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SAMSUNG

EVO QIO

Quickly meets Quality

The EVO Q10 is more than just a portable ultrasound; it is a decisive tool engineered for the
dynamic Point-of-Care environment. It is meticulously designed to empower clinicians where
it matters most—at the patient's side—enabling rapid screening, confident diagnosis, and
precise procedural guidance. With its exceptional image clarity, Al-powered automated tools,
and a remarkably intuitive workflow, the EVO Q10 removes complexity, allowing you to make
critical decisions with speed and certainty. This system not only accelerates the diagnostic

process but also elevates the standard of immediate, patient-focused care

Quickly meets Quality Q10 2 Product Design Lab/CX Team
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General Imaging

+ AutoIMT+

- BowelAssist™

* Button Probe

« ClearVision

* CrystalVue™/CrystalVue Flow™
« ElastoScan+™ (E-Strain™)
+ EzAssist™

« EzZCompare™

- EzDiagram™

« EZExam+™

« EzFlow™

« EzGuide™

* EZHRI™

« EzPrep™

« EzStructure™

« EzTrainer™

« HQ-Vision™

* LumiFlow™

« MirrorTouch

« Mobile Export
« MultiVision

* MV-Flow™

- NeedleMate+™

* NerveTrack™
« Panoramic+

» QuickScan™

* QUS(TAI™, TSI™)
« RFA Viewer

Quickly meets Quality Q10

SAMSUNG

 S-Detect™ for Breast
« S-Detect™ for Thyroid

« S-Shearwave Imaging™
+ SonoSync™ and System Requirements
+ Voice Command

« Transducer Line-up

Product Design Lab/CX Team



SAMSUNG

Gyn OB

- 2D Follicle™ * 5D CNS+™

« 5D Follicle™ + 5D Heart Color™
- EzPictogram™ + 5D Limb Vol. ™

. IDEA 5D NT™

- [ETA + ADVR (Video Recording)
« IOTA-ADNEX « BiometryAssist™
« IOTA-SRrisk * EzCheck™

- UterineAssist™ * EzTrainer™

« UterineContour™ * Free Angle Plane
« EzTrainer™ « HDVI™

* Free Angle Plane « LaborAssist™

« MirrorTouch « MirrorTouch

« Transducer Line-up « RedlisticVue™

« Smart 4D - 3D Xl > MSV(Multi Slice View)
» Smart 4D - 3D XI > Oblique View

* Smart 4D - 3D XI > VOCAL

* Smart 4D - 3D Xl > Volume CT

« Smart 4D - MagiCut™

* Smart 4D - XI-STIC

« ViewAssist™

« Transducer Line-up
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SAMSUNG
cv

« ArterialAnalysis™
* AutoEF
* AutoIMT+

« EzAssist™

« EzDiagram™

« EzGuide™

« EzTrainer™

* HeartAssist™

« MirrorTouch

« Strain : Clinical summary & overview
« Strain+ (LV Strain)

« StresskEcho

« Transducer Line-up
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Ergonomics

15.6” (LED Backlight Unit)

Mirror Touch

Streamlines workflow with
mirrored touchscreen for
instant, intuitive control

Clutter-free workspace '
T o s
Smart cable = :
management keeps the ' v
focus on your patient : J :

Quickly meets Quality Q10 6

SAMSUNG

Flexible positioning

Quick tilt and height
adjustments for any
scenario

Multi-purpose basket

Versatile basket for
variety of items

Compact and mobile
Small footprint allows
For exceptional
maneuverability

Product Design Lab/CX Team



Ergonomics SAMSUNG

Main System

Sophisticated Design with High Durability from Magnesium

Pearl White

Multi colored Pearl White

Camera & Sensor/MIC

- IP22 Water resistance
. *Applied to CP only
Camera Activated —

~Certified W

14”

Complies with IEC 60529 IP22: Protected against solid objects of 12.5 mm and greater, and
against vertically falling water drops when the enclosure is tilted up to 15°, for 10 minutes.

Track pad / ball (optional)

High resolution speaker

Quickly meets Quality Q10 7 Product Design Lab/CX Team



Ergonomics

Cart (Option)

........

Cable Hanger R 1

(Right 2 units, Left 2units)

Gel warmer (L/R mterchangeable

5” Single Castor (4 locks)

HM70 EVO Q1O
EVO Single Caster

"asily rolls over the floor cables

SAMSUNG

System detachment from the cart

@Take off

Front tray
(Large / Small optional)

. A Probe extension
Dual VLa%lpal prc;]be / Gebllholder 3 port)
Caster (L/R interchangeable)
Front tray Power cable hook
Rear tray
| <y
G .

Quickly meets Quality Q10

- ;@ghdaptorstorage
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SAMSUNG

Ergonomics
Cart - Height adjustment rage Height adjustment 300mm range
Accommodates various body sizes and scanning
postures(sitting or standing)
N«& ‘
- " = \“_:
_ *;==: 300mm
y Y Ve (820mm~1120mm)
4444444444 i | Aligned with trackpad center
. M‘
y [ noe! 6 g
—[ —f{ >
e D [} v
Cart - Tilting
W
@
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Ergonomics SAMSUNG

Cart — Accessories

Detachable w/o any tools Cable cover

ECG, USB etc

Hide the cable
inside
Power/USB

Probe cable
Rubber band hook

Power cable
Hook
(prevents dragging)

Gel warmer

Gel holder
(*L/R interchangeable) (Vaginal probe can be
stored)

(*L/R interchangeable)

Front tray (Small)  Front tray (Large)
(Upper/Lower position selectable) — 7.

Quickly meets Quality Q10 10 Product Design Lab/CX Team



Ergonomics SAMSUNG

Battery

Battery Life

Internal: 90min.
External: 270min.
Total 360min.

SYSTEM battery (2 units)

o e

~
’
4

EPP(Cart-mounted battery module)
. 6 Battery Units

Quickly meets Quality Q10 11 Product Design Lab/CX Team



2D Follicle™ SAMISUNG

Feature

A feature based on Deep Learning technology.
Detects follicle’s boundaries and contouring to present a size and volume.

Individual follicles are listed up in order to its size.

Clinical Benefit

Follicle size measurement is routine study in IVF, helps to reduces keystrokes and improve patient
throughput compare to the manual measurement.

Long, short, Average and Volume is shown as result, and able to assign the Laterality.

Easy of usage — Freeze the view and tap the 2D Follicle button on the TouchScreen, all the result will be
provided with a single step.

Tips

Endocavity Transducers are supported.
Decrease a depth to get ovary image bigger and access the 2D Follicle.
Follicles can be selectively displayed by Early, Middle, Post stage.

Select the Follicle by hovering your arrow or rotate the knob key on the far left to remove from the result
and image.

Utility > Setup > Measurement > Application option > GYN page.
- Set each stage’s standard size and sorting criteria as user preference.
- Follicle’s Average information can be hidden.

Enter “Day of Stimulation” on the patient page.

Quickly meets Quality Q10 12 Product Design Lab/CX Team



5D CN5+T™ SAMSUNG

Feature
+ Based on deep learning technology, feature for fetal brain assessment with 3D volume data.

« Extracts 9 diagnostic planes (MSP, TT, TV, TC, TFc, TCaudc, TTc, TCc, PSP) with anatomical landmarks and
biometric measurements (BPD, OFD, HC, Vp, CM, CEREB) automatically.

Clinical Benefit

* Provides additional anatomic information to identify the brain structural anomalies and defects, with
robust detection within a short time with fully automated process.

« Simplifies fetal brain assessment and improves workflow efficiency.

« Reduces inter-observer variability of acquiring 9 diagnostic planes.

Demo & Manipulation Tips

» Optimize the 2D image in Transverse fetal brain view and acquire a 3D volume.
» Required view: Take the Trans-Thalamic View and do a 3D rendering

+ Acquire a 3D when baby is stable to take a good volume image quality.

* Fully automated: No seed point is required.

+ Position, Bias, Chroma map adjustment would be useful to optimize the result image more sharper or better
contrast.

Quickly meets Quality Q10 Product Design Lab/CX Team



5D Follicle™ SANMSUNG

JSAMSIZJIITG‘ ok 1 M MPR

Stage

Antral Adc ‘ Delete
Merge

Init

View
‘ A B Slab3D @& Back

C 3D Review Slice Assign to Report

Min

Feature
» Afeature based on Deep Learning technology.

+ Automatically identifies and calculates follicles to display the chart : Volume, Size and total numbers based
on 3D data in different colors intuitively in left side.

Clinical Benefit

+ Ableto observe and understand targeted follicles relationship between adjacent structures in multi-planar
view with 3D volume, would be useful for IVF procedure.

« Improve a diagnostic confidence on assessing ovarian follicles by accurate detection and measurement,
decrease user dependency.

+ Supports to raise a productivity and patient throughput.

Tips
* Volume transducers are supported : EV2-10A

+ Optimize 2D image to take a good 3D quality, usually increasing a contrast would be helpful to improve a
detection rate.

» Fityour 3D ROI to the Ovary to exclude an unnecessary area.

* Follicles can be selectively displayed by Early, Middle, Post stage or Min-Max.
Each stage’s standard size setting is available in the setup page, Intuitive visualization for both user and
patient.

Quickly meets Quality Q10 14 Product Design Lab/CX Team



5D Heart Color™

SAMSUNG

5D Heart Color

- 3 Three Vessels & Four-Chamber Five-Chamber o
L Trachea View View View | i3 IR

-
5.ChQEIBer View

LeftVentricular  SROTtAXis of the

e 2 View
Trachea View Outflow Tract Great Vgsels/ Abdomen View Labels

L. . :;
4charabief View

- “a i Ductal Arch Aortic Arch Venae Cavae

VIS-Assistance
= - P y
s« 2NQLLAXIS Of She Abdomen View
Great Vessels, RVOT

-

S — Play /Pause
e £

-~ -

k b MOTMieW.« Proto Diastole Proto Systole

T

-
BPM/Phase Adjust

s
=
-

Ductal-Arch Aortie Arch Venae Cavae

Feature
» Fetal Intelligent Navigation Echocardiography method was applied to STIC dataset to exam a fetal echo.

+ Fetal heart Color information can generate successfully nine standard fetal echocardiography views
outlined by AIUM and ISUOG Guidelines with single volume dataset.

Clinical Benefit

» Contributes to a comprehensive fetal echocardiogram by showing 9 different views simultaneously, will
give valuable information on cardiac structural and functional integrity, especially clinicians with less
experience.

« An Operator-independent tool —VIS-Assistance- specifically designed for further improvement of
successful diagnostic plane reconstruction is offered.

» Able to evaluate each view of fetal cardiac motion as well as hemodynamics.

Tips

+ 2nto 3 Trimester fetus is recommended.

» 9 Standard Fetal Echocardiography Views.

: 3VV and Trachea, 4ch, 5ch, LVOT, RVOT, Abdomen, Ductal Arch, Aortic Arch, Vena Cava

+ Cardiac Axis value, Fetal Echo View name, Anatomical Labels can be shown in Diagnostic Planes.

A: Transverse aorticarch
Ao: Aorta

Desc: Descending

IVC: Inferior Vena Cava
LA: Left Atrium

LV: Left Ventricle

P: Pulmonary artery

PA: Pulmonary Artery

Quickly meets Quality Q10 15

RA: Right atrium

RV: Right ventricle

RVOT: Right Ventricular Outflow Tract
Superior vena cava

Stom: Stomach

SVC: Superior Vena Cava

TR: Transverse

Vent: Ventricular

Product Design Lab/CX Team



5D Limb Vol.™ SAMISUNG

5D Limb Vol. Guide SAMSUNG 2024-05-20

12:20:54 PM

Feature
+ Semi-automated to measure fractional limb volume for fetal weight estimation.

« The Volume result that taken by 5D Limb.Vol™ (Fractional Arm volume, Thigh volume) can be added to
conventional 2D measurements, BPD, AC to improve the precision of EFW.

Clinical Benefit
» Address challenges that conventional fetal weight prediction model doesn’t include soft tissue parameters.

« Improved the precision of estimated fetal weight by adding a volume result to 2D anatomic measurement.

Tips
« EFW Author table need to be assigned as Lee1 or Lee 2 in advance to the study. 5D Limb Vol. Guide
- Leelis for BPD, AC and Avol.
- Lee2 is for BPD, AD and Tvol.

+ Scan alLong bone’s Longitudinal plane, make it parallel to the 3D ROI line acquire one Edlin
a 3D volume prior to do the 5D Limb Vol™. A

if caliper placement is incorrect

selection

*Avol: Lee W, Balasubramaniam M, Deter RL, Yeo L, Hassan SS, Gotsch F, Kusanovic JP, Goncalves LF, Romero R. New fetal weight estimation
models using fractional limb volume. Ultrasound Obstet Gynecol, in press.

*Tvol: Lee W, Balasubramaniam M, Deter RL, Yeo L, Hassan SS, Gotsch F, Kusanovic JP, Goncalves LF, Romero R. New fetal weight estimation
models using fractional limb volume. Ultrasound Obstet Gynecol, in press

Quickly meets Quality Q10 16 Product Design Lab/CX Team



5D NT™ SAMSUNG

H Caliper Placement

Cursor r
i

OntoOn
(inner to inner)

Cursor

IntoIn

On to Max-
Brightness

Feature

+ Semi-automatically finds the right plane to assess a reliable NT measurement and calculation based on
volume data. Automatically finds the mid-sagittal plane from acquired volume data and measures the
maximum NT(or IT) distance in few seconds.

Clinical Benefit

» Proper measurement at the maximum distance of NT may difficult to perform especially to beginners who
is not used to find a true mid sagittal view.

» Provides High inter- and intra observer reproducibility between experienced and inexperienced physicians.

Tips
+ Find a standard nuchal translucency plane as much as close to the mid sagittal view and take a volume.
+ Click the cursor on fetal diencephalon.

+ Caliper placement method can be selected depends on user’s preference in the TouchScreen.

OntoOn P
usaor rrl_]
Place the cursoron the NT’s inner-inner for B
measurement.
I
BTl
On to Max Brightness P
_ Sl *NT (Nuchal Translucency) : Between 11-13
Place one of the cursors on the outside of NT/IT and
) : . weeks and 6 days of pregnancy. To assess the
measure the inner-outer. This method is useful when sk of ch / . diti B
harmonic is used and one side of the translucency is risk of chromosomal or genetic conditions suc,
blurred. oy as Down syndrome, Edwards syndrome and
Patau syndrome.
Intoln Cusor o *IT (Intracranial Translucency) : Between 71-13
Similar to On to On, this method takes measurement weeks of gestation Translucent area in the fourth
with inner-inner, albeit with a narrower cursor ny ventricle, parallel to the nuchal translucency,
interval. Neural tube defects such as open spina bifida.

Quickly meets Quality Q10 17 Product Design Lab/CX Team



ADVR (Video Recording) SAMSUNG

5D Follicle samsung | OUCE

Recording ADVR USB Play

ADVR USB Play

Recording Area

Feature

+ Video recording tool, useful to save a specific time range of video for training or lecture for physicians,
trainees or for family to memories a baby’s ultrasound.

Tips

+ Video recording file is stored on the connected External storage via USB Port.

+ Able to start and stop a recording while ultrasound scanning with User key.

» Two type or Recording Area is provided : Scan Area / Full Screen.

* Redrecordingicon is displayed on the left bottom corner of a monitor when ADVR™ is working.
* Toreview the recorded video, Go to ADVR™ USB Play and select a specific file to play.

* Recording time and capacity is depends on the media’s storage.

Quickly meets Quality Q10 Product Design Lab/CX Team



ArterialAnalysis™ SAMSUNG

SAMSUNG

ArterialAnalysis

Image Only < et 2 placeme 6Segment

Trajectory 7 gEE 3 Strain Select Range Pos.

Endo+Epicardial ‘ Strain Rate

Velocity Vector Alpha Blending Velocity Calc. IMT

, . Max.Diameter _ _ Min Diameter .
Position < position 7

Feature

» Provides consistent images and clear resolution across various view depths from a near area to a far area of
an ultrasound image without requiring the user to manually adjust the focus.

Benefit

 ltdetects function changes in blood vessels, providing measurements such as carotid artery stiffness, IMT
thickness and pulse wave velocity.

+ Since functional changes occur before morphological changes, ArterialAnalysis™ aids in the diagnosis of
cardiovascular disease.

Tips

+ Linear transducers are supported, with single-mode imaging, ECG trigger off,
and patient information entered.

« Early detection: Enables preventive care by identifying cardiovascular risks early.

 Risk assessment: Offers quantitative measures (e.g., carotid stiffness, IMT) for personalized risk
stratification.

« Treatment monitoring: Tracks changes in vascular function to guide therapy adjustments.

Quickly meets Quality Q10 19 Product Design Lab/CX Team



ArterialAnalysis™ SAMSUNG

« Measure Table : Press “More” button

SAMSUNG

® Intima-Media Thickness (Far) 8 Stiffness

Peak Values.

ircumferential

Time to Peak Values

Circumferential

Assign to Report

Index Definition Unit
Stiffness Index The ratio of the natural logarithm of SBP/DBP to the relative change in diameter
Arterial Compliance The absolute change in vessel area for a given change in pressure mm/kPa
Distensibility The relative change in vessel diameter for a given change in pressure kPa!

The pressure change required for (theoretical) 100% stretch from resting

Elastic Modulus(Pet . ) ) kP
astic Modulus(Peterson) diameter (inverse of distensibility) a
Pulse Wave Velocity(Beta) Speed with which the pulse wave travels along a length of artery m/s
Augmentation Index(Central) A measure of wave reflection and arterial stiffness (defined for a central pressure %
(diameter) waveform)
P dsRaeE) A measure of wave reflection and arterial stiffness (defined for a peripheral %

pressure (diameter) waveform)

Quickly meets Quality Q10 Product Design Lab/CX Team



AutoEF SAMSUNG

LVEDW A4C ; Sl

Feature
» Auto EF is an automatic tool for measurement of global ejection fraction.

« Itisameasurement, expressed as a percentage of how much blood the left ventricle pumps out with each
contraction.

» The percentage of End Diastolic Volume (EDV) ejected after each contraction. (Systole)
- EF = (EDV-ESV)/EDV * 100% (Normal range is 56~78%)

- If resting EF is <30% a person’s exercise capability will be significantly reduced.

Male Female
Normal Mildly Moderately Severely Normal Mildly Moderately Severely
range abnormal abnormal abnormal range abnormal abnormal abnormal
LV EF(%) 52-72 41-51 30-40 <30 54-74 41-53 30-40 <30
MaximumLA volume/ | 4, 3, 35-41 42-48 >48 16-34 35-41 42-48 >48

BSA(ML/m?)

* ASE Guidelines (Long et al. /] Am Soc Echocardiography 2012;25:3-36)

Clinical Benefits
» Auto EF provides fast, accurate and reproducible LV ejection fraction measurements.

Measurement : SV (Stroke Volume), EF (Ejection, Fraction), GLS (Global Longitudinal Strain)

Left Ventricular ES(End systole)
Volume(ml) volume

LLd

Volume graph (simpson’s rule)

Quickly meets Quality Product Design Lab/CX Team



AutoIMT+ SAMSUNG

SAMSUNG - AutolMT+

8
e e et

Near+Far

Analysis

Auto I MT+ Laterality . Location N p Font Size
Rt ? Prox ¢ 20

Feature

« Automatically detects an intima-media thickness of the Carotid (Common carotid artery, Internal Carotid
Artery, External Carotid Artery).

» Presents Mean, Max, SD Thickness of the intima/Adventitia pair and Standard deviation as a result.

Clinical Benefits

* Quick and simple assessment for IMT measurement is supported.

* Intuitively show the detected line as different color (Green to red) depends on the IMT thickness result.
» Both Near and Far IMT can be assessed.

» Provides the distance ratio of the measured point in a distance for Quality Index measurement.

Tips

+ If the vessel image quality is poor, select an area that is close to the Intima to be measured when user need
to update the result.

- Contrast image is recommended, increase a reject level or decrease a gain would be helpful.

« Measurement results table.

Mean The average thickness of the Intima/Adventitia pair
Max The maximum thickness of the Intima/Adventitia pair
SD Standard Deviation
qQl The distance ratio of the measured pointin a distance for Quality Index measurement
nPoints The total number of the measured Intima/Adventitia pairs

Quickly meets Quality Q10 22 Product Design Lab/CX Team



BiometryAssist™ SAMSUNG

A 1Trim. 2-3Trim. Basic Echo X

Patient

Fetal Cranium Fetal Long Bones Fetal Others Maternal Others r"_Df'E

Change
Author

AC FL HUM EFW Result

Hadlock Hadlock Asum(scw)

™ NF NB Worksheet

Cervix L

End Exam

General Measure

o . AuthorPreset ‘ X e Auto Delete Last

Utility

EFW

Execute

Feature

» Afeature based on Deep Learning technology, is an semi-automatic function for fetal biometric
measurement.

« Itenables users to measure the fetal growth parameters with one click while maintaining exam consistency.

+ Semi-Automatically measures the following anatomical structures: BPD, HC, AC, FL, HUM, those are main
items required for estimating fetal weight. Tap the desired item on the TouchScreen.

Benefit

» Enables users to measure the growth of the fetus quickly with greater accuracy while maintaining exam
consistency.

» Reduces repetitive measurement tasks in ultrasound examination.

- For experienced users, it shortens examination time.
- For beginners, standardized measurements help obtain consistent results, increasing confidence in
diagnosis.

Tips
+ BiometryAssist™ items are selectable in the Utility > Setup > Assist > OB Page.

+ “Assist” is shown on the measure items on the button that is working as the BiometryAssist™.

BPD HC o ac FL

Hadlock Hadlak Hadlock: Hadlasck:

vp s M NF
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BowelAssist™ SANMSUNG

BowelAssist

Transverse Colon

Colon Froximal fleum MP-5M-M

ending Colon Terminal ileum

Initialize Delete Last

Feature
» BowelAssist™, powered by deep learning, reduces keystrokes by up to 80%.

+ The user simply draws a box-shaped target area over the bowel wall, and the system automatically
measures: MP (Muscularis Propria), SM (Submucosa), M (Mucosa), and BWT (Bowel Wall Thickness)

Clinical Benefit

» Provides standardized and reproducible measurements of bowel wall layers, which are critical for assessing
disease activity and monitoring treatment response in Inflammatory Bowel Disease (IBD), including
Ulcerative Colitis and Crohn’s Disease.

Tips

+ Lineartransducer is supported : LA2-9SD
» Select the desired Orientation (LONG or CSS) at the bottom of the screen.

» If needed, select a Location (e.g., Caecum, Ileum, Ascending Colon, Transverse Colon, Descending Colon,
Sigmoid Colon, Rectum).

» Draw a box over the target area to initiate automatic detection and measurement.
» Tap Assign to link the selected Location and Orientation to the result, which will be recorded in the Report.

+ If BowelAssist™ does not appear on the touchscreen,
go to Utility > Touch Customization and verify that BowelAssist™ is enabled.

Quickly meets Quality Q10 Product Design Lab/CX Team



ClearVision SAMSUNG

ClearViSionTM Off i — . i ) : ClearViSionTM O‘n #45/92

Feature
» A speckle (granular texture) reduction technology.

« The noise reduction filter that is designed to remove distracting speckle noise artifact.

Clinical Benefit

« Noise at tissue boundaries is removed to provide a clear tissue interface, create clear images, and improve
contrast differentiation.

* Reduces halo artifacts that occur when tissue contours are enhanced.

Tips
* Theindex can be adjusted according to the user's preference.

- A lower index helps to make the speckle and natural pattern.
- The higher the index, the smoother the image.

* Supports post-processing.

- You can change the index from the stored image in any time to change it into various patterns and save it
again.

Quickly meets Quality Q10 Product Design Lab/CX Team



CrystalVue™/CrystalVue Flow™ SAMSUNG

B MPR MSV Oblique

Patient

= Preset

-
v . Select
S 2D

ot 3 Syrface vsi > —— = Post

e = g

¥ - HODVI Type . Processin

) . ¢ HDVI > < e MagiCut 9
. ClearVision

Report = — —

. Clearvision Specular3D Chroma
5 & 4 < >
SanoView

Accept ROI

Light
Slab 3D o Direction

E ~ = VOCAL

3D Cine

End Exam

Utility

. Transparency

Feature

« CrystalVue™ is context preserving rendering technology and provides morphological information, while
conventional 3D visualize only surface information.

+ Visualize both interior and exterior structures, anatomical details in transparency mode with the ability to
differentiate between different tissues as well as vascular.

Clinical Benefits

» Displaying normal anatomy and fetal malformations with high volume image quality, useful throughout all
trimesters either in normal or in pathologic cases.

« More detailed structures which having a different level of voxel strength can be demonstrated such as
Bony, cartilage, skin, vascular branching or parenchimatous organs, even cavity organs.

Tips

« Quickly accessible to the CrystalVue™ by tapping the RealisticVue/CrystalVue of the Render Preview on
MPR Mode TouchScreen, based on the Color 3D data.

+ Able to optimize an image with more opacity or transparently or enhance a context information using the
Strength, Transparency, Complexity. 5 different default User preset is provided in RenderSetup page.

Quickly meets Quality Q10 26 Product Design Lab/CX Team



ElastoScan+™ (E-Strain™) SAMSUNG

Color Invert

Dual Layout

< Sidebyside ~

. Alpha Blending

[ ]
[ ]
[ ]
®
[ ]
[ ]
[ ]
[
[ ]
[ ]

Strain A
Strain B
Ratio (B/A)

Frequency P Line Density p Persistence o | e Enhancement .

Next

Feature

+ Non-invasive diagnostic tool based on differences of stiffness between malignant and benign lesions based
on ElastoScan map.

« Mainly useful in breast application, stiffness ratio between the lesion and reference could be one of a
criterion to define malignancy risk.

 Intuitively noticeable the lesion’s hardness with stiffness map’s pattern and color.

Clinical Benefit

+ Qualitative evaluation is supported by providing a compression guide bar, helps to reduce an user
dependency.

* Quantitative assessment is available by providing the strain ratio. * Ratio (B/A) = Reference ROI/Target RO/

Tips

+ Fit the Compression guide bar as level 3-5 is recommended with natural compression.

« ROI A would be Target lesion and ROI B would be a Reference, which is a fat tissue in Breast.
» Make ROl size fit to the lesion, to include a region.

+ Same ROl size and place them in similar depth is recommended for an accurate comparison.

Quickly meets Quality Q10 27 Product Design Lab/CX Team



EzAssist™ snM su NG

= Temp_2
SAMSUNG

Feature

» Provides the anatomical information of the human body at the screen to guide easy ultrasound scanning for
untrained people.

Clinical Benefit
» Areference tool to be used at the discretion of a professional caregiver in non-clinical settings.

 ltis helpful to use as a educational tool for beginners who need to get used to the procedure with
ultrasound scanning, such as Vascular access, Regional Anesthesia, Pain treatment (Nerve block), MSK
scanning, Emergency and so on.

Tips

+ Assign the EzAssist on the User key and use as a shortcut function is available.
« Alltransducers are applicable except the Pencil probe.

* Procedure lists

- Vascular, Regional Anesthesia, Pain Treatment, MSK, Epidural and spinal, Rescue block, Emergency

Quickly meets Quality Q10 Product Design Lab/CX Team



EzCheck™ SNMSUNG

2D 2D
Fetal Head IF N s Fetal Head

Fetal Face

- Nose/Lips it rafile

Report Fetal Face Nose/Lips Orbit cenor Orbit Prafile
Profile -0

[ Brofile Fetal Abdomen "

Diaphragm Bladder

Fetal Abdomen Abdomen Stomach Diaphragm

[ B The Fetal MSK -

End Exam Kidney Bladder £no £xam Utra/Rativs.

-] Cord " -]
utitty

Tibia/Fibula

The Fetal MSK Spine Humerus
Fetal Gender

2nd Trimestar (Level 2) «= 0/29 2nd Trimester{Level 2}

A List View A Picto View

Feature

+ EzCheck™ identifies whether required images or biometry values have been acquired during the exam.

Clinical Benefit

» Itdisplays an intuitive scan progress status, helping users complete the exam by tracking missing items in
real time. The standard pictogram view on the touchscreen is especially helpful for beginners in identifying
and scanning required views.

+ Measurement results and GA (gestational age) information are shown below each corresponding view,
allowing users to review all key data at a glance without accessing the report page.

Tips
+ Activate EzCheck™ from the patient registration screen before starting the exam.

Patient

&l Patient First Name

Abdomen Breast SmallP. MSK Vascular Pediatric Adult Echo
-

dy Information EzExam+,

DOC(LM]

» Users can choose between List View or Picto View, and monitor scanning progress in real time with a clear
display of completed items vs. total items (e.g., 5/29).
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EzCompare™ SAMSUNG

Patient

& ratient

Breast SmallP. MSK Vascular Urology Pediatric

Previous Image  Current study

Feature J

» Allows easy access to previously taken exams to evaluate corresponding views in a side-by-side display.

+ EzCompare™ automatically set image settings, Annotations and Bodymarkers from the prior study.

Clinical Benefit

« The cases that require follow up, it creates the same scan environment such as image parameter, Color PRF
to support accurate and easy comparative study.

« Provides improved usability, EzZCompare™ enables to save a time consumption and reduce keystrokes.

Tips

« Find a exam on Search Tab on the Patient page > Select an Exam » Click the EzCompare button.
Multiple exams can be selected under the Same Patient ID.

» Previously stored images are listed up on the right side on a Scan Mode.
+ Select the images that you desired to make a comparison.

« Same image parameters of previous image are presented regardless of the preset.
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EzDiagram™ SAMSUNG

samsung AN 2D EzDiagram

(71 Lung stiding : Absent

171 Lung Point ; Present () Pneumotharax

("] Consolidation ("] Pulmonary Edema
(7] Preumonia

(L) Pleural Effusion

Enlarge Bookmark ’ Summary

Monitor Screen Touch Screen

Feature

« EzDiagram is a feature that helps users easily create standardized reports by placing ultrasound images
with specific findings on a predefined body map diagram and adding descriptions during exams such
as Lung Ultrasound, eFast.

Clinical Benefit

+ EzDiagram offers lung/eFAST with a truly streamlined workflow, seamlessly integrating real-time
documentation and connected to report.

Tips

* You can configure EzDiagram related items in Utility > Setup > Imaging > Features.

Diagram Type Auto Sequence Findings & Diagnosis Report

i

Auto Next step on Save

€ Reset © Rusat

| ] Not Seen
Abnormal

ung Paint

: Present [] Pneumothorax

I Pulmonary
edema

(] Pneumonia

(] Pleural effusion

Indet.

Indet.

Indet

ndet
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EzExam+™ SAMSUNG

Patient

Patient

a/R
Auto ID Creation
+ New Patient

Start EzExam+

1st Trimester

Feature

* You can create routine ultrasound examination protocols to reduce the number of steps required to press
multiple buttons and supporting complete the exam.

Benefit

+ It helps to reduce keystrokes and repetitive motions therefore reducing the risk of RSI (Repetitive Strain
Injury).

« ltisvery usefulin hospital settings and sonographers where certain images are necessarily required.

Tips

It provides customizable automation at each step of an ultrasound exam providing a fast, comfortable &
consistent scanning experience.

* The whole exam sequence is displayed down the side of the monitor.

« ltisalso possible to go back to the previous step or jump forwards to other steps if necessary during the
examination.

» Setup an user’s protocol with EzExam+ creator
Utility > Setup > System > EzExam+
* Tocheck for using EzExam+

Patient > Start EzExam+
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EzFlow™ SAMSUNG
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MV-Flow g Yo ual Live 0 o= MV-Flow

Next Reset

A Abdomen Application A OB Application

Feature

+ Automatically fine-tunes imaging parameters — including gain, scale, wall filter, and baseline — with just
one button press. It streamlines the optimization process for C/PD/PW modes, helping users quickly obtain
high-quality vascular images without manual adjustment and enabling quick optimization for specific
vascular structures, acting like a color preset.

Benefit

+ Improves efficiency in routine Doppler exams by reducing manual adjustments, delivering optimized
vascular imaging for confident diagnosis with less effort.

« Forthe Abdomen preset, EzZFlow™ provides targeted optimization for structures like renal vessels or
conditions like twinkling artifacts, enabling consistent image quality in routine exams.

+ For the OB preset, up to six kinds of detailed EzFlow™ presets can be configured per preset unit. For
example, Uterine A., MCA, Umbilical A., Ductus Venosus, Fetal Heart and Pulm. Veins color presets can be
set for the 2nd Trimester preset.

Tips

« InC/PD/PW Doppler modes, press the desired EzFlow™ preset on the touchscreen to instantly apply
optimized settings for the target vessel.

+ In Utility > Setup > Imaging > EzFlow™, you can manually adjust individual imaging parameters.
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EzGuide™ SAMSUNG

2D

Pericardial Assessment

Abdominal Free Fluid

2 RUO{Morison's 3 Lua (Splenorenal

A 5
pouch} recess) Pelvie view (Trans) Pelvie view (Lang)

Modity

Thoracic Assessment
End Exam

®  RAnt Thorax 7 L Ant Thorax 8 P © -
(Sliding) (Sliding} R Lat Thorax (Fluidy L Lat Thorax {Fluid)

o Collapse Group

(U)eFAST

Feature

» EzGuide™ acts as an expert guiding you. Anyone can achieve an accurate scan just by following the
anatomical drawings and reference images.

It provides major protocols such as eFAST, Blue, Rush, and Basic Cardiac, which are ideal for beginners.

Clinical Benefit

« By providing a scan guide based on major protocols, it helps users, especially non-experts, to perform
accurate examinations, and can also be useful for educational purposes.

Tips

* When used with EzExam+, it ensures you complete the protocol in the set order without omission, further
enhancing the quality of the exam.

"Create your own Scan-guide Protocols”
- Customizable Protocol Default Protocol in EM/CC
Display menu
* Probe Position eFAST
» Ultrasound Anatomy
« Reference BLUE  £9
» Editable Protocol
RUSH 9
Reference * Image insertion
US image - JPEG, BMP, PNG, ) )
: - AVI (up-to 10MB) Basic Cardiac @
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EZHRI™ SAMSUNG

SAMSUNG

Kidney

Reset ROI

Liver 110.12 utility
Kidney 89.32 -

ROISize

HRI(L/K) 1.23

Feature

+ Hepato Renal Index(HRI) is an index used to compare the brightness level in the hepatic parenchyma with
that in the renal cortex.

+ Afeature based on deep learning technology, Two ROl is automatically shown in liver parenchyma and renal
cortex based on segmentation information once user launch the EzHRI™

Benefit

» Suggests quantitative value which could be useful to grading the fatty liver stage rather than visually
compare the Hepato-renal echo intensity.

« Improve workflow efficiency with automation features that reduce the number of steps required to enter
measurements and annotations for each item each time.

Tips

« The performance of EzZHRI™ can be affected by shadow artifact and unclear margin between liver and
Kidney, which means, image parameter and image quality could affect to the result value.

» Please refer to the below table : Probe/Preset Configuration

Probe Application Preset
Abdomen Abdomen, Penetration, Renal
CA1-7SD
Emergency Abdomen, FAST
Abdomen Abdomen, Renal
CA2-8AD
Emergency Abdomen, FAST
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EzPrep™ SAMSUNG

Patient screen

& Patient

Setup page

Feature

+ EzPrep™ s a function that automatically selects the transducer and preset based on the Worklist or
manually inputted in the System Setup page when start an exam on the patient page.

Clinical Benefit
» Doesn’t need to select a Transducer/Preset selection as exam started, so it improves repeated work-steps.

» EzPrep can be addressed based on Worklist Description/Obstetrics GA/BMI information which would be
frequently on User’s behaviors.

Tips

+ Utility > Setup > System > EzPrep™
- Refer to worklist description and refer to GA type are provided.
- Probe connection is required for EzPrep™ setting.

- UserPreset can be assigned as a EzPrep well.
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EzStructure™ SAMSUNG

Extremity
Spine

Abdomen

Fetal Heart

MV-Flow Dual Live - oz MV-Flow Dual Live

A Abdomen Application A OB Application

Feature

+ EzStructure™ is a 2D image optimization tool designed to deliver preset-specific image tuning based on the
target anatomy.

« For example, in the Abdomen preset, users can instantly optimize the image for Lung, FAST, Pericardial,
Aorta or penetration by selecting the corresponding button — with manual adjustments available as
needed.

Benefit

+ Improves image consistency and saves time by providing fast, anatomy-tailored optimization during real-
time scanning, especially helpful in exams covering multiple abdominal structures.

Tips

* Inreal-time 2D mode within the selected preset, tap the desired EzStructure™ option from the touchscreen.
* Itisavailable in Abdomen, Small Parts, Emergency, OB, GYN and MSK Applications.

« Parameters such as frequency, gray map, and ClearVision are instantly applied for optimal visualization.

+ In Utility > Setup > Imaging > EzStructure™, you can configure each individual image parameter, and assign
a corresponding EzFlow™ to be applied with each EzStructure™ selection.

» If EzStructure™ does not appear on the touchscreen, go to Utility > Touch Customization and verify that
EzStructure™ is enabled.
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EzTrainer™ SAMSUNG

Extrsiner
v System Overview System Overview
Probe Port
Onthe console

With the console itself, there s one port on the right side of the system.

Onthe cart

With a cart, up to 3 probes can be connected to ports located below the console on the back side of the cart, The ports are connected to a probe connectorwhich is
attached to the right of the console. Probes can be connected to th anytime, whether the system 5 turned o or of

Probe Connection

Onthe console

» Viorkflow

> Cleaning

FAGS insert the probe vith the tall of the cable facing the user, and raise the probe lock to have It fixed. Press down the probe Lock to release the prose.

Onthe art

Feature

« Basicinstructions for the user who just get started the System.

Clinical Benefit

» For the user: By implementing brief and essential user guide on the system, it is helpful to find quickly and
is well informed of how to use the system themselves.

+ For the Sales/Application specialists : Use the EzTrainer as a introduction tool to the users who just getting
started the system.

EzTrainer

¥ Systern Overview

Prohe Port

Tlps Probe Connectlon
Progic Holder

+ Utility > EzTrainer Sacuring a Prabe

X Probe Direction Markar
* EzTrainer’s contents are; L
. . . Monitor
- System overview, Getting started, Workflow, Cleaning, FAQs I

System lranspartation
Slakug Display
Manitor Soreen Layout
Touch Screen Layeut
P

Consale Mront

Lell Si I lhe Cansale

Hight Side ot the Consale
Rearof the Consala

Control Keys

® Getting Started

- Warkflow

* Cl2aning

* FAQ:
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EzPictogram™ SAMSUNG

EzPictogram

Fibroid 1
Delete

Uterine Fibroid 2

Type

Uterine Fibroid 2
Position

Uterine Fibroid 2

Comment

Save as Image

. IndicatorSize

Feature

Simplify reporting with optimized workflow of picturing and recording the location of the lesion instead of
drawing manually.

Benefit

An advantage of this approach is that it allows physicians to show the location, size and righting of the
fibroid, along with the ultrasound images, in a system that does not draw them directly on paper, but rather
in conjunction with the PACS in their consulting room.

Tips

Directly assign the Fibroid type, Position and Comment, those are linked with the Report page.
Supports options to be shown on the Pictogram: Uterus flexion type, Transverse, Coronal view of uterus.

To convey more accurate information, the size of the Fibroid can also be displayed differently by adjusting
the indicator size.

Pictogram can be saved as an image itself with “Save as image”

This function can be accessed by entering Measurement and pressing EzPictogram on the touch screen.
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Free Angle Plane SAMSUNG

-, ’
- P

FreeAngle Plane
0° > 30° >

Feature

» Free Angle Plane feature allows for flexible imaging by enabling clinicians to obtain views at various angles
without physically repositioning the 3D transducer.

Clinical Benefit
» Increased Efficiency : Time-saving, Streamlined workflow

« Enhanced Patient Comfort : Reduce movement, Less disruption, Reduced stress

Tips
» Useful for gynecology application like uterus, both ovaries and adnexa.

« For a patient with challenging ovarian visualization due to lateral or superior adnexal positioning, a
postmenopausal patient experiencing significant discomfort during transvaginal examinations, or a patient
with an ectopic pregnancy or complex cyst/mass in severe pain.

« This featureis available on the 3D vaginal transducer. It allows the scan head to be adjusted to the desired
angle without moving the transducer, enabling the observation of sequential planes on both sides.

+ User can observe images by sweeping based on the elevation angle without moving the probe and it
supports a range from -40°~40.
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HDVI™ SAMSUNG

Feature

« HDVI™ (High Definition Volume Imaging) is a volume rendering technology that improves visualization of
edges and small structures in volume data.

» Afeature that applies 3D Matrix processing based on voxel by voxel of 3D volume data as well as A/B/C
Plane’s image quality.

Benefit
* Improves the ability to distinguish boundaries and structures in 3D images.

« The expression of different textures for each organ can be improved.

Tips

« Provides various types considering the characteristics of anatomical structures. Usually Face, Surface type
is recommended for the 2" -3rd Fetal Face and Early OB for 15t Trimester.

» Step-by-step settings are possible by adjusting the index.

+ Upgraded marginal expression and image saturation expresses the very details from angle to shadow of the
fetus.
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HeartAssist™ SAMSUNG

Measure

Cardiac

£ WVVol.(Simpson)

Review

Feature

» Afeature based on Deep Learning technology, provides automatic classification of ultrasound image into
measurement views required for adult/pediatric heart diagnosis and provides measurement results.

Benefit

+ Simplifies the time-consuming measurement process, improving examine efficiency and increasing the
accuracy and reproducibility of measured values.

* Presents Pediatric Z-Score as well.

Tips

« ltis enabled under the following conditions:
- Application: Cardiac
- Operation mode: 2D, M, PW, CW, TDW(Freeze A}EH)

+ HeartAssist™and Ped Echo Z-Score should be turned on in the Setup Page.
Utility > Setup > Assist » Cardiac > HeartAssist On.
Utility > Setup > Measurement > Application Options > Application (Cardiac) > Z-scores On.

General Display Menu Application

System
Cardiac
Imagin:
(0] Urology 9ing
Assist RAP Default Value Default

System
Settings

on Frozen Image Measurement

Imaging

Report

Annotation

Start HeartAssist by Pressing Measure Key

Measurement K
BodyMarker Ped Echo

Customize

Peripherals
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HQ-Vision™ SANMSUNG

SAMSUNG SAMSUNG

HQ-Vision™.Off HQ-Vision™:0n

Feature

« Animage processing algorithm that provides clearer images by mitigating blurring of real objects due to the
physical properties of ultrasound.

Convolution: Image Formation Deconvolution: Inverse Filtering

Captured

~ Image (9)

Scan Obj t()\A@ .
can Objec
—>

' / Restored

) ' Image
PSF; Point Spread |:> Modelling
Function (h) PSF

Clinical Benefit

» Enhances spatial resolution which improves the sharpness of structure.

Tips
+ HQ-Vision™ cannot be used with NeedleMate+™ while in 2D mode.

* HQ-Vision™ can be used in 2D mode, 2D/C mode, and Write Zoom.

Useful when performing detailed imaging of the fetal spine as well as its subtle interfaces. (e.g. NT, NB, etc.)

oB
Could be recommended to the users who prefers sharp image patterns as well as for 15t Trimester study.
MSK Useful when performing detailed imaging of the nerve’s fibrillary pattern
Abdomen Reduces noise and clearly expresses boundaries when checking structures such as liver capsule and CBD
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IDEA (International Deep Endometrioses Analysisgroup)  SRNMSUNG

2D IDEA

Step 1 (Routine) Step 2 (Soft Markers)

Anterior Urinary Bladder

Compartment

a

IDEA
Report

Yes (Obliterated) No (Mobile)

End Exam to (= 7 J

Cancel

Feature

» Provides a standardized reporting system for deep endometriosis based on the latest IDEA consensus
guidelines.

« Offers a systematic and structured approach to ultrasound examinations for endometriosis, ensuring all
relevant anatomical locations are assessed.

* Includes standardized terminology and pictograms for accurately mapping and describing the location, size,
and extent of endometriotic lesions.

Clinical Benefit

» Supports beginners, who may lack an understanding of IDEA Consensus Terminology and protocol, in
following the guideline.

» Astreamlined study is available, from ultrasound image acquisition and description to reporting, allin front
of the system.

Tips

» Directly access the IDEA report section with the 'IDEA Report' button.

« Pictograms are provided for each criterion for comprehensive understanding.
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IETA (International Endometrial Tumor Analysis) SAMSUNG

Frozen 2D |ETA Frozen 2D IETA

Endometrium Endometrium

Fluid
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End Exam End Exam

lese

Endo Myometrial

Junction Regular Irregular Interrupted

Feature

+ Implements the IETA (International Endometrial Tumor Analysis) consensus statement on terms, definitions,
and measurements used to describe the sonographic features of the endometrium and uterine cavity,
including Grayscale, Color Doppler, and Saline Infusion Sonohysterography (SIS).

Clinical Benefit

» Assists non-experts or beginners who may be unfamiliar with the IETA consensus terminology for
describing ultrasound findings related to endometrial tumors.

» Helps users create accurate and standardized descriptions by providing the IETA criteria directly on the
system.

« Enables a streamlined workflow, allowing users to perform ultrasound image acquisition, record
descriptions, and generate reports—all directly on the system.

Tips

» Directly access the IETA report section with the 'IETA Report' button.
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IOTA-ADNEX SAMSUNG

2D |0TA-ADNEX

Main

Max. Diameter Max. Diameter
of the Lesion of the Solid Part
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Data Clear

Frequency . FocusNumber

Mext

Feature

» The ADNEX Model developed by Ovarian tumor classification solution of IOTA Group, is applied to
ultrasound system.

« Therisk model to differentiate between benign, borderline tumors, stages 1 - 4 and metastatic cancer.

Clinical Benefit

« IOTA-ADNEX provides an auto fill-in function for ultrasound predictors(Diameter of lesion) as soon as they
are measured, provides streamlined workflow and supports user-convenience.

» Provides seamless workflow that all procedures can be performed in one system, from the image
measurement to an analysis with reporting.

Tips

» Patient’s age is required start the IOTA-ADNEX, enter the patient page in advance is recommended.

e Serum CA-125 information would be make result more accurate. SAMSUNG ULTRASOUND
0l (V6] C130 Name CA1-7AD, GYN, ADNEXA
Date of Birth(Age) 1972-08-14(52y0m) Gender Exam Date 2024-08-14
Indication
Diag. Physician Ref. Physician Operator
Gynecology
LMP Ovulation Date Gravida Para Ectopic Aborta
‘IDTA-ADNEX
Chance of Benign Risk of Malignancy Age of the Patient 52 years
98_8% 1 _2% Oncology Center? No
Riskof  Borderline 0.7% RR=p17  Max-Diameter of the Lesion 3879 mm
Stage 1 0.2% RR-0.03  Max. Diameter of the Largest Solid Part 0 mm
Stage TI-IV 0.2% RR=0.01 More than 10 Locules? No
i 0.1% RR=0.03  Number of Papillatif ]
Risk of malignancy is <10% (not elavated). "
Note that tt do not take the CA-125 level inte Acoustic Shadows Present? No
" e Ascites Present? No
(IOTA) grou tion providing statis tical Serum CA-125

100
&0
"3
10
n
o J
eassine lsts it s StaaeTV el
W Benign M Borderline M Stage |
W Stage II-IV M Metastatic ®:Ba A ; Patient Risks
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IOTA-SRrisk (Simple Rules risk)

Feature

2D 10TA-SRrisk

Unilocular Irregular Solid
Solid Ccfiyoonent Ascites

Paplillary2 4

Irregular
Multilocular

Very Strong
Blood Flow

SAMSUNG

Diameter

» |0OTA-SRrisk is a tool that calculates the probability of malignancy in adnexal masses using the IOTA Simple

Rules model.

« lItanalyzes morphological features such as solid areas, papillary projections, and acoustic shadows to

support diagnostic decisions.

Clinical Benefit

+ Provides standardized malignancy risk estimation based on internationally recognized criteria.

» Reduces diagnostic variability and supports confident clinical decision-making in adnexal mass assessment.

» Easy-to-understand results enhance communication between clinicians and patients.

Tips

» Select from Simple Rule features: B-rules (benign) or M-rules (malignant) such as:

p B1: unilocular cyst, B2: presence of solid components <7mm, etc.

p M1:irregular solid tumor, M2: ascites, etc.

» If ageis not entered during patient registration, please ensure to input age, as it may affect risk estimation.
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LaborAssist™ SANMSUNG

LaborAssist
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Direction Up

Feature

+ Automatically detects and contour the pubic symphysis outline with fetal head outline to show the AoP
(Angle of Progress), complies with the metrics specified in the ISUOG Guideline.

Clinical Benefit

« More accurate and less subjective than digit examination (Palpation) to see the descent of the fetal head to
decide upon the mode of delivery.

« Anultrasound examination is not only useful during labor, but also facilitates an easy measurementand a
quantitative assessment, as it is non-invasive and requires relatively less skill to scan the patient.

» Simple to manage the delivery plan with the labor history and easy to make understand a pregnant women
with Demo Video Animation about current descent status.

Tips

+ In Utility > Setup » Measurement:
- Set LaborAssist™ mode (Auto/Manual) under Application Options with OB selected.
- Choose reference table (Tutschek, Barbera, Kalache) under Tables according to preference.
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LumiFlow™ SAMSUNG

SAMSUNG SAMSUNG

S-Flow™ with LumiFlow™ MV-Flow™ with.LumiFlow™

Feature

« A function that uses light source effects to visualize blood flow in three dimensions.

Camera

peflect Increases
srecon Diffuse

\

Light

Benefit
« Helps to understand the structure of blood flow and small vessels more intuitively.

+ It would be useful for evaluating fetal heart abnormalities in Color Mode for hemodynamics such as
dysplasia and regurgitation of the valves and so on.

Tips
» Supportedin Color, Power Doppler, S-Flow and MV-Flow™ mode.
» Bright areas of blood flow do not reflect actual high blood flow velocities.

«  Would be helpful to express the boundaries more tightly.
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MirrorTouch

Feature

Probe Center
Lin TGC

Dual Live

> [« »

Frequency , Frame Average ClearVision

Next

SAMSUNG

Reject

» This feature mirrors the ultrasound image and menus from the main monitor onto a separate touchscreen.
This allows the user to operate the equipment by directly touching the screen while viewing the same

interface.

Clinical Benefit

It provides intuitive control and image viewing on a single screen, which allows for fast and efficient
operation during quick procedures.

Tips

* You can demonstrate the intuitive controls, such as using pinch-to-zoom to magnify or shrink the image, or
dragging the image with a finger to move to the desired area on the touchscreen.

Touch Gesture Operation

Tap

Quickly meets Quality Q10
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Mobile Export SAMSUNG
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Temp
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Feature y

J
* Send acquired ultrasound images to family’s mobile phone in simple way so they can keep the babies
pictures as a handy data instead of hardcopies or printed one.

Clinical Benefit

» Usually Baby’s 3D images are preferred, helpful to increase the customer’s satisfactory and amusement as
well.

« The workflow steps of sending and receiving is simple and easy via QR Code.

Tips
» User

1) Enter “Sonoview”

2) Click the images to select and transfer to customer’s mobile.

3) Click the “Mobile Export” button of the bottom.

4) Click the Export button when customer’s device is ready to get.
» Customer

1) Tag the QR code through a Mobile phone’s Camera.

2) Check the ID is same as monitor screen and enter the Password when confirmed.
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MultiVision SAMSUNG

SAMSUNG SAMSUNG

MultiVision™ Off : MultiVision™ On

Feature
» A spatial compounding technology.

« By transmitting beam-steering technology, multiple images are acquired from various viewing angles and
these angled images are combined into a single compounded image in real-time.
- For multiple images : The number of images is used as an odd number, such as 3, 5, 7, 9, etc.
- For various viewing angles : The angle is used between 2 and 12 degrees, and is modified and applied
according to the situation.

* The reason why the angle cannot be widened too much is because grating lobe artifacts may occur.

Clinical Benefit

« Angle-generated and speckle noise artifacts could be reduced, and structures with curved and irregular
borders are more readily visualized.

« The boundaries of lesions or structures appear improved and vertical shadowing artifacts are reduced.

Tips
« Astheindexincreases, there is an increased possibility of motion artifacts and a loss of temporal resolution.

*Using a high index can slow down the image and may result in visible grating lobe artifact.
* Recommend to use considering temporal resolution.
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MV-Flow™ SAMSUNG

Feature

» Advanced Doppler Imaging for micro vessels with Slow Velocity, visualizes microcirculatory and slow blood
flow.

» Advantages with Superior sensitivity, Higher Resolution and Fast Frame rate.

» Supports advanced assessment for various applications like OB, GYN, Abdomen, Small part and MSK.

Clinical Benefits
For Obstetrics,

+ Helpful to define the Fetal Central nervous system, straight sinus and pericallosal artery, which could be
one of criteria to diagnose a congenital defect anomaly.

« Renal, suprarenal artery, placenta, cervix vascularity that suggested in the context of suspected placenta
accrete spectrum.

For General Imaging,

« By visualize more sensitive, smaller, slower vascular morphologies compare to the conventional color
Doppler, it is more supportive to evaluate the Color Doppler aspect.

Tips
» Toreduce aFlash artifact or Tissue noise, turn up a few step of Filter or Suppression.

« Vascularity Index measurement is supported, which is a quantitative tool to measure amount of blood flow
in defined ROI. (e.g) Placenta assessment in FGR (Fetal Growth Restriction) Case.

«  LumiFlow™is compatible, may helpful to depict vessels more clearly.

Ratio(%)

Pixels

Vascularity Index
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NeedleMate+™ SAMSUNG

NeedleMate+ OFF NeedleMate+ ON’"

Feature

« Beamsteering is additionally applied to the image to make the angle of the needle path and the beam
perpendicular, making the needle more visible.

Benefit

« ltis easy to determine the position of the needle tip during intervention such as nerve blocks.

Tips
« Needle Direction: Sets the entry direction of the needle in images.
* Needle Angle: Sets the entry angle of the needle in images.

* Needle Enhance: Sets the enhancement and thickness of the needle.

Enhance Level Description
1 Needle thickness is thin and needle enhancement is low
2 Needle thickness is thin and needle enhancementis high
3 Needle thickness is thick and needle enhancementis low
4 Needle thickness is thick and needle enhancement s high
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NerveTrack™ SANMISUNG

SAMSUNG

NerveTrack™ : ROI NerveTrack™ : Segmentation

Feature
» Afeature based on deep learning technology.
+ Identify nerve structuresin real time during the application of anesthesia.

« Real-time nerve tracking ultrasound feature that helps anesthesiologists identify nerves in a patient’s arm
and leg to help administer anesthesia quickly and accurately.

Benefit

+ Automatically identify nerves in real time for anesthesiologists reducing the possibility of complications
while improving workflows.

» Shorten inspection time, finding the nerves in real time even if the doctor does not trace from the wrist to
the proximal direction. Help safe needle procedure by allowing the nerves to be separated from the
surrounding tissues and vessels.

Tips
« (Can be used with NeedleMate™ and Probe center Line with NerveTrack™

» ROI: Pressing [Information] allows you to check the traceable nerve area information.
Segmentation: Pressing [Guide] displays a guide window for each nerve area.

Tracking Type Tracking Type

‘ 2{0]

Segmentation | Segmentation |

Information Guide

ROI Type Segmentation Type

Quickly meets Quality Q10 55 Product Design Lab/CX Team



Panoramic+ SI\MSUNG

SAMSUNG SNMSUNG

Panoramic+ with Breast Panoramic+ with Thyroid

Feature

» Extend the field of view of ultrasound images for clinical diagnosis especially when the region of interest is
bigger than scan area.

« Common clinical use case is the superficial application like Thyroid, Breast and MSK with linear transducer.

Clinical Benefit

« Ableto visualize a huge lesion or organ in a single view due to pathologies in superficial application like
thyroid goiter or huge breast mass.

+ Helpful to understand the anatomical relationship between huge lesion and adjacent tissues without view
restriction.

Tips
+ Measurement, Caliper, Annotation on Panoramic+ image is available.

» Image processing parameters such as ClearVision™ and MultiVision™ can be applied so it maintain a good
image quality even on a extended view.

* Recommend to do a one-way Longitudinal direction Scanning.
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QUS(TAI™ TS|™) SAMSUNG

SAMSUNG

- Attenuation Mean: average
S —Coefficient.Scale

Median: locating the center
number

Attenuation : IQR: A measure of spread that
$olor g | shows the difference between
3 1 the first and third quartiles of a
S et data set
B
i N
Measurement,
Result Box

IQR/Median: A value that can be
used to distinguish between
groups of data

Feature

- TAI™(Tissue Attenuation Imaging) is a tool that quantitatively measures the attenuation of ultrasound
signals received from the liver. TAI™ Quantifies attenuation based on changes in the center frequency
under the optimal transmission and reception conditions.

« TSI™(Tissue Scatter Imaging) is a tool that quantifies the scattered signal distribution based on
backscattered signals. Scattering, the reflection of ultrasound waves in multiple directions not affected by
their entry angle, produces speckles patterns in ultrasound images and this changes the distribution of
backscattered ultrasound signals based on the scattering intensity.

-

N/ % X
— — - \ =
F ' """ i U PN | C
Attenuation Backscatter Speed of Sound

Phy5|§al Energy loss of ultrasound wave Scatten.ng !)y t:he microstructural Speed of ultrasound wave
meaning properties in tissue

. . . . Reliable estimation of the
US image H_ypoech.0|c appearance at !—Zchogenlc appearancein US sound speed could improve
appearance distant field image : .

image quality

Relationship
with Fatty Increasing with fat content Increasing with fat content Decreasing with fat content
liver
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QUS(TAI™ TS|™) SAMSUNG

Benefit

* Improve workflow efficiency with automation features that reduce the number of steps required to enter
measurements and annotations for each item each time.

+ Itisanoninvasive, cost effective and accurate screening for nonalcoholic fatty liver disease (NAFLD).

Tips
« How to use the QUS
1) Patient’s preparation/Position
- Fast overnight (at least 6 hours) before the examination.
- Supine or left lateral oblique decubitus position with the right arm in maximal extension.
2) Obtaining B-mode
- Ensure good contact with adequate gel.
- Acquire plane perpendicular to the right lobe.
- Scan the right intercostal space, image liver segments 5 - 8 keeping the liver capsule parallel to the probe
surface.
3) Measurement
- Take a result values with R*2 of 0.6 or higher, which meet the minimum reliability.
(The reliability of the ultrasound feature is connoted to the extent to which it can explain a significant portion of the data,
indicating that this feature is likely to be clinically useful and a trustworthy diagnostic tool)
- Obtain 5 results for each image is recommended.

- Quick transition between TSI™ and TAI™ is available with user keys.

SAMSUNG

tesr Name
Date of Birth(Age) Gender Exam Date
Indication

Attenuation i
= Coefficient-Scale I L

Diag. Physician Ref. Physician
" Operator
< Abdomen
Attenuation

E Height Weight
Color Map 1

Fat Fraction : 14.65%
TAI Mean 0.89 Median 0.87 Mean 92.17 Median 92.
IQR 0.09 IQR/Med. 10.48 IQR 3.95 IQR/Med. 4.2
ROI Value (dB/cm/MHz) R? Value
0.90 0.51 93.41

S 0.98 0.73 92.31
Measurement,_| TAI[dB/cm/MHz] 0.85 072 88.02
Result Box 0.59 (R"20.88) 0.84 0.56 94.82

0.87 0.63 92.30

\
L

el A (N

T

* Mean : average.

* Median : locating the center number.

*IQR : A measure of spread that shows the difference between the first and third quartiles of a data set.
* IQR/Median : A value that can be used to distinguish between groups of data.
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QuickScan™ SAMSUNG

Feature

¢ Q-Scan™ provides intuitive optimization of B/C/D parameters.

Benefit

+ Time saving : By semi-automatically optimizing image quality, users do not need to manually adjust various
settings, saving significant time, especially in busy clinical environments.

+ Convenience : Users can obtain optimized images without complex adjustments, making it easier for those
who are less experienced with ultrasound to achieve high-quality results.

« Reduced Fatigue : Reducing the effort required to manually adjust settings decreases user fatigue, which is
important during long sessions with multiple examinations.

Tips
+ 2D Mode: Automatically adjusts Gain, DR, and TGC.
+ PW Spectral Doppler Mode: Automatically adjusts Scale, Baseline, and other parameters.

+ Color Doppler Mode: Automatically adjusts Box position and other parameters.
(Available only when the Carotid and Arterial presets for the Linear Array probe are selected.)

 If probe position or angel changes, altering the view, press the Q-Scan™ button again to update the image
accordingly.
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RealisticVue™ SAMSUNG

SAMSUNG horied Gray RealisticVue RealisticVue CrystalVue Gray CrystalVue

Tls 0.2/Tib 0.2/N

, | Specular3D

Clear SFV N /RN Invert

Feature
+ Create a vivid and realistic fetus 3D/4D volume images on all stage of gestation.

 High resolution and natural skin expression with optimized volume filter.

Clinical Benefit
+ Enhancing stereoscopic depth and volumetric effect with local shading compare to the conventional 3D.

« User selectable light source direction creates intricately graduated shadows for better defined anatomical
structures.

« Helpful to demonstrate detailed malformation criterions and may give a precise view such as palpebral
fissures for down syndrome, cleft lip and early anomalies like gastroschisis with a light source adjustment.

Tips

+ Click the Contextual key to assign the Trackball action as a Light Direction and manually change the light
direction with trackball movement.

- 8different default color for RealisticVue™ are provided and Color fine tuning is available with Hue,
Saturation, Brightness adjustment in RenderSetup page.

« For more glossiness, increase the Specular index in RenderSetup page, the other way makes RealisticVue™
more natural.
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RFA Viewer

(Total)

Total ablation time : Indicates
the time at which
radiofrequency ablation was
performed.

Total energy : Total amount of
energy delivered to the tissue
during the ablation process.

(Channel)
Time : Time of operation

Q : Impedance (Ohms)
é}: Power

& : Temperature (Degrees Celsius)

M Time : Indicates the lap time for a RF ablation.

M Impedance : Indicates the resistance value of the targeted tissue at the time of RF output.

RFA Viewer

ch
01:19
86°C

o]
29120
20W
2009 J

SAMSUNG

SAMSUNG

M Power : Indicates the actual amount of radiofrequency power that is supplied to the electrode and targeted tissue.

B Temperature : Measures the temperature of targeted tissue from the active tip.

Feature

» RFA viewer displays information in real-time, such as total ablation tine and total energy, generated by the

RFA Generator.

« RFAviewer is a feature that provide information from the RFA generator or logger, allowing the same
information to be viewed on the ultrasound monitor.

Benefit

« Helps the user focus solely on the ultrasound monitor screen during the procedure.

* Improve workflow efficiency with automation features that reduce the number of steps required to enter

measurements and annotations for each item each time.

+ Depending on the hospital environment and the size of the procedure room, the generator may not be
placed close to the ultrasound. In such cases, additional personnel might need to assist with the procedure,
but with the RFA viewer, this is unnecessary, allowing more focus on patient care.

* Compatible StarMed RFA Viewer Model : VIVA RF Generator, VIVA multi RF Generator,
VIVA combo RF Generator, VVR Generator.
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S-Detect™ for Breast SAMSUNG

| Indication
Diag. Physician Ref. Physician Operator

Left #1

Distance 0,00 cm Possibly Benign

Depth 1.08 cm Classification BIRADS2003
Marker Gap 5cm Shape oval

Width 114cm Orientation Parallel

Height 0.38cm Margin Circumscribed
Area . 2 Lesion Boundary Abrupt Interface

Feature
» Semi-Automated Imaging Reporting System, decision making support tool for Breast Assessment.

« Analyzes selected lesions in the breast ultrasound study and shows BI-RADS ATLAS (Breast Imaging-
Reporting and Data System, Atlas) to provide standardized reporting with recommendation.

+ BIRADS 2003, BIRADS 2013 are provided.

Clinical Benefit
» Decision making tool for classify the Breast lesion semi-automatically.

+ Assist beginners by providing BI-RADS Assessment Category Score recommendation and they may regards
it as a second opinion.

+ Distance, Angle, Depth, Width, Height, Area is automatically calculated and shown on left side.

Tips

+ Set the proper guideline before on Setup page depends on user preference.
Utility » Setup > Imaging > Features > S-Detect for Breast

« Able to change the classification result manually depends on user’s opinion.

» Assign the BIRADS Score is available as a final decision.
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S-Detect™ for Thyroid SAMSUNG

Feature
» Semi-Automated Imaging Reporting System for Thyroid Assessment.

» Analyzes selected lesions in the thyroid ultrasound study and shows the analysis data, provides
standardized reporting based on the following guidelines, and helps diagnosis with the streamlined
workflow.

- ATA: American Thyroid Association

- BTA: British Thyroid Association

- EU-TIRADS: European Thyroid Imaging Reporting and Data System
- K-TIRADS: Korean Thyroid Imaging Reporting and Data System

- ACR-TIRADS: American College of Radiology TIRADS

Clinical Benefit

« Improves analysis efficiency with semi-automated workflow by providing related lexicon automatically
with lesion’s size and area information together.

» Reduces unnecessary thyroid biopsies by suggesting an accurate and consistent category score
recommendation.

Tips

+ Set the preferred reference guideline before on Setup page
depends on user preference.

Utility > Setup > Imaging > Features > S-Detect for Thyroid
+ Able to change the lexicon result manually depends on user’s decision.

+ Assign to Report to deliver all result to the Report page.
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S-Shearwave Imaging™ SAMSUNG

S-Shearwave Imaging SNMSUNG 5D SWI
B c D Abdomen / CA1-7SD / 17.0cm/ 10Hz & & M TR
9.13 1201
en

1.44

155 Color Invert Depth Guide

Dual Layout

< sidebyside Profile

, RMialphaBlending . | | AlphaBlending |
60 % M 60 % 4

s

Site A

ROI 10

Mean

SD

Min

Max 10.86kPa

Diameter 1.0cm - P Site | e Persistence . RMIThreshold . Elasticity Range
RMI 0.90 ’ ’ ’ o1 aokps

Feature

* Non-invasive assessment for a stiffness of tissue/lesions in various applications such as breast, liver and
MSK. It provides color-coded stiffness map with quantitative measurements data as well as RMI (Reliable
measurement index) map together.

* ltusesan acoustic radiation force pulse sequence which propagate perpendicular to the tissue, causing
transient displacement and generates shearwave to the transverse direction.

N4

Focus E

/ 1 \jofttissue
Clinical Application Benefits GG e G

+ Liver: Monitor disease progression. It can help diagnosis and stage liver cirrhosis and differentiate between
more subtle forms of liver dysfunction.

Shedrwave direction

» Breast: It can help identify malignant versus benign breast lesions and can reduce the number or biopsy
needed.

« MSK: It can evaluate tendon, muscle, nerve, ligament and joint. It can help assess the stiffness and
elasticity of tendon after healing.

Beneficial workflow

« Shearwave measurement ROl can be sequentially addressed on the acquired individual frame in following
condition: Freeze with “Meas.” + Next Frame for Measurement “Auto”.

+ More detailed option could be find in Utility > Setup > Imaging > Features > S-Shearwave Imaging
- Next Frame Direction (Forwards/Backwards)
- Next Measurement Cursor Display position (Reset / Keep Last position)
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S-Shearwave Imaging™ SAMSUNG

S-Shearwave Imaging SAMSUNG
B c D Abdomen / CA1-7SD / 17.0cm / 10Hz . & Tis 05/TIb 05/MI 15

9.13k (201
Gen

)50 | Caution

= Livercapshle'
>1.5cm :| i

e

ean
D

RMI map Elasticity map ™=

Tips

[Scan Recommendations]

1. Fast at least 4 hours before the examination.

2.Scan on intercostal area in the supine or slight left lateral position with the right arm in maximal extension.
3.Image liver segments 5, 6, 7, or 8, keeping the liver capsule parallel to the transducer surface.

4. Position the ROl at least 15~20 mm away from the liver capsule and locate it in the center of the image.

5. Ask patient to breath normally and hold the breath, avoiding deep inspiration prior to the breath hold.

6. At least 5 measurements should be obtained in different image frames to increase reproducibility.

* Measurement reliability criteria are values less than or equal to IQR/Med (kPa-30%, m/s-15%)

[Reliability Indications]

1. RMI(Reliable Measurement Index) Value must be higher than 0.4.

2. Recommend to referring the RMI map color, set the measurement ROl in the greenery region.
3.1QR/Med Ratio (kPa) should be lower than 30%. (/QR/M should be lower than 15% for m/s)

4. Median value should be taken as the representative value of the Shearwave Study.

[Result display options]
Measurement Summary item, Order of Elasticity Measurement and Elasticity Ratio can be arranged.

Utility > Setup > Imaging > Features > S-Shearwave Imaging
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Smart 4D - 3D XI > MSV(Multi Slice View) SAMSUNG

SAMSUNG MPR MSV Oblique

Show All Rulers Auto Contrast Negative

Post.

. Hmﬁwe N Processing
Face 3Dl

= Chroma
e Thick HOVI
o5mm > 2 Volume CT

Central View Orientation Dot Slab 3D

‘ G

Pasition . ias . SelectedSlice

Feature

« 3D Xl (eXtended Imaging) is the 3D data manipulation tool to improve diagnostic accuracy.
It supports MSV, Oblique View, VOCAL, XI VOCAL and Volume CT modes.

« MSV (Multi Slice View) is a feature that allows you to view an image in multiple sequential slices.

Benefit

- Based on each section (sagittal, axial, and coronal planes), you can sequentially see each image cut into
slices in various display format like CT or MRI.

Tips
* Inthe case of 2D, simultaneous comparison of multiple images with one acquired image is not possible.

 Inthe case of MPR (Multi Planar Rendering), each of the sagittal, axial, and coronal planes can be confirmed
in only one image area.

 Inthe case of MSV (Multi Slice View), you can set the desired layout and view multiple frames of sequential
images at once.

+ MSV’sindividual image’s interval can be changed by Slice Thick. If more detailed observation between the
structure is required, please change the interval thickness to be more thinner.

Quickly meets Quality Q10 66 Product Design Lab/CX Team



Smart 4D - 3D XI > Volume CT SAMSUNG

SAMSUNG MPR MSV Oblique

Patient

Preset

E Q Show All Rulers Auto Contrast RECEE

— — Post
¢ CFierpe o HOVIType
HDVI

Processing

3Ddl

Chroma

SonoView

Central View QOrientation Dot Slab 3D [0}

= ) VOCAL

End Exam

]

Utility

Position

Feature

* Volume CTis a feature that reconstructs 3D volume data into multiple cross-sections of external and
internal slices to check the structure of the fetus from different angles.

Benefit

» By showing sagittal, transverse, and coronal planes together, you can check the connectivity of anatomical
structures as well as relationship in three dimensions.

Tips
+ Only available in MSV and Oblique page.
* Cube Volume CT: Shows the external slice image of a cube.

+ Cross Volume CT: The internal cross-sectional images where the sagittal, transverse, and coronal planes
intersect are shown.

A Plane Offset Adjust the position of the Front Surface.
B Plane Offset Adjust the position of the Up Surface.
CPlane Offset Adjust the position of the Left Surface.

Volume CT

+ If ‘Boundary’is turned 'On’, the boundary lines of a cube will be shown.

Boundary lines indicate the external boundary for the entire volume data. ' Volume CT Type
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Smart 4D - 3D XI > Oblique View SAMSUNG

SAMSUNG MPR MSV Oblique . . &
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Feature

« Oblique View is a feature that freely cuts the desired cross section from volume data using the cutting
method selected by the user and visualizes it as a plane.

« OVIX (Oblique View eXtended) is a feature that displays the image with volume by setting the cross-
sectional thickness of the oblique image.

Benefit

+ Parts that are not easily visible in traditional 2D images can be observed from various angles, allowing for
detailed evaluation of specific organs or structures of the fetus.

Tips

» After drawing a straight or a curved line on the selected image in MSV Mode, you can observe the related
oblique image.

« Anoblique image will appear with the start (S) and end (E) points shown.
« If Cut Typeis set to Line and the trackball is in Move state, you can reposition the line.

* In curved structures such as the spine or the face of a fetus, using the curved type helps obtain more
accurate images and shows you the coronal view.
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Smart 4D - MagiCut™ SAMSUNG

SmoothCut Type Cut Type

Erase Small

Erase Big Outside Contour

Recovery Small Inside Box

Recovery Big Outside Box

Small Eraser

Big Eraser

Feature

Feature to cut out or carve specific area from 3D images.

Benefit

MagiCut™ allows you to digitally erase or carve any structures in front of the image, creating a structurally
unobscured 3D image.

Tips

This simple, user-controlled feature quickly eliminates a specific target within the volume and can also
easily recover the erased information by reversing the action.

Itis suitable for removing structures in the amniotic fluid in front of the fetal face.

Available in MPR Mode only.
If MagiCut™ is enabled, ‘Accept ROI’ is turned on automatically.

Cut type can be easily used as box, eraser type, and contour.

Press ‘Undo All’ to cancel all tasks that have been done so far.
Press ‘Undo’ to cancel the latest task.

* SmoothCut

- One of the MagiCut™ functions is to create smooth skin when the fetus's facial surface is expressed as being
uneven.
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Smart 4D - 3D XI > VOCAL SAMSUNG

SAMSUNG SAMSUNG

[VOCAL] ) & |I [XI VOCAL]
1L Off N n = -~
0 ~

Feature

« VOCAL (Virtual Organ Computer Aided Analysis) is a feature that traces and recognizes the outlines of
structures of various anatomical or eccentric shapes, and then calculates 3D volumes. In 3D with PD,
vascularity histogram is supported for vascularity quantification.

Benefit

« Measuring specific ROI's volume from 3D data for quantification, provide more accurate values than
measuring volume from 2D images.

Tips

» VOCALvs. XI VOCAL

Measures the volume of an object in a general 3D image

HoIgA Uses rotating slices

Measures the volume of an object in the selected reference image in MSV Mode
XI VOCAL Uses parallel slices
Calculates the volume of an object by cutting it into multiple slices

« Contour Type

Solid For hyperechoic object data
General Draw a contour line based on a typical object
Prostate For prostate data
Cystic For hypoechoic object data
Sphere After creating a sphere object, edit its contour 2 to create the desired shape
Manual Manually create the desired object shape
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Smart 4D - XI-STIC SAMSUNG

SAMSUNG  Touch A MSV  Oblique

Gesture
X1 STIC
Heart Rate 145
Scan Time 12s

Render o] veT MagiCut
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Render Setup Accept ROI

y ) 4 3D Cine
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off HDVI

Feature

« XISTICis a mode to acquire the heartbeat period of the fetus and the STIC (Spatio-Temporal Image
Correlation) volume data using a 3D transducer.

Benefit

+ Useful for diagnosing arch abnormalities.
(e.g. DORV; double-outlet right ventricle, neck vessels, coarctation of aorta, etc.)

Tips

@ Press the [4D] button and then select X1 STIC' tab.

@ Press [Freeze] or [Set] to start acquisition of 3D images.
@ Check the fetal cardiac cycle calculated on the screen.

* |f the motion artifacts are severe, the data does not contain the cardiac cycles, or the heart rate cannot be
calculated for any other reason, you will be returned to the XI STIC initial screen.

* How to Improve STIC Volume Data

Specify a small angle for small fetal hearts.

Angle
E Transverse plane : same as the gestational age in weeks.

Sagittal plane : same as the gestational age in weeks plus 5°.

Adjust the scan position so that the center of the angle and the fetal heart are aligned properly.

Scan Position In order to avoid shadowing from the fetal spine and ribs.

ROI Box Adjust the size of the volume box so that it nearly fits the size of the fetal heart.
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SonoSync™ SAMSUNG
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Feature

» Real time image sharing solution that allows live streaming, communication and remote control of
ultrasound system for collaboration between physicians and sonographers at different locations.

» Remotely control the counterpart’s US system by personal computer with virtual TouchScreen and Control
panel to perform B/C/D Mode adjustment, measurement, annotation and so on.

+ Voice chatting with marking tool, Text chatting and video conference function are supported for smooth
discussion.

» Encrypts data as per HIPAA guidelines and CE-marked to ensuring security.

Clinical Benefit

» E-Consultation : Connecting sonographers at a satellite imaging center with an expert physicianina
hospital for remote consultancy.

+ E-Collaboration : Multi-department discussion within the hospital or a complicated case, multiple us
system can be connected to one smart device.

« E-Training : Supporting online education or webinars to medical and Sono-school students with live
ultrasound scanning, multiple users from different smart devices to an us system is available.

« E-Demo: Present a new feature and research outcomes for knowledge transfer.
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SonoSync™ System Requirements SAMSUNG

Recommended Requirements

Server

e CPU:Intel Xeon 4 Core, 3.00 GHz or better
* RAM:32GB or more

» Disk:50GB or more

* NIC:1Gbps Ethernet or faster

+ 0OS:Windows Server 2022 or later

Mobile Device Recommendations
» Phone : Samsung Galaxy S21 or later
» Tablet: Samsung Galaxy Tab S7 or later

Viewer — PC/MAC

* CPU:Corei3orabove

* RAM: 4GB or more

* Resolution : 1920 x 1080 pixel resolution or higher

« 0S:Windows 10 64bit or later, macOS11 or later

« Web Browser : Chrome v91 or above (exclude incognito mode)

Viewer — Mobile
« 0OS:Android 11 or later
« Web Browser : Mobile Chrome v91 or above

Network Requirements

Ports
e TCP443 : htts (Web/WebSocket)
« TCP1935: WebRTC

Bandwidth

» Server:1Gbpsor more

+ Ultrasound System : 6 Mbps or more per each
+ Viewer: 6 Mbps or more per each

Other Requirements

SMTP
» Account registration/Password recovery
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Clinical overview & summary: What is Strain ? SAMSUNG

+ Strain measures myocardial deformation.
Strain =L1-L0O/LO *100
L1: Length at a given pointin time, LO: Baseline length

 Strain rate is the addition of the concept of time to Strain.

» Most common clinical application is LV GLS.

Direction Longitudinal strain Radial strain Circumferential strain

Systole Shortening = -ve Thickening = +ve Shortening = -ve
(Diastole) (Lengthening = +ve) (Thinning = -ve) (Lengthening = +ve)

* Adapted from Anderon B, Echo Hawaii 2018. ase.org

- Differences and Pros & Cons of GLS/GCS
There are research results that GCS is more closely related to EF.

Pre-clinical dysfunction > Rapidly reflects LV function decline, allowing early prediction of dysfunction.

Spatial integral

Velocity " Strain Rate
(mm/s) P (1/s)

Spatial integral

Time integral
SAIIBALIDP SWI|
Time integral
DAIBALIDP S

P
<

P

<

Spatial integral

»

Displacement Strain Rate
(mm) _ (no unit)

Spatial integral
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SAMSUNG

« Global Longitudinal Strain (GLS)

Lagrangian strain is defined as the change in length of an object within a certain direction relative to its
baseline length. Where ML is myocardial length at end-systole (MLs) and end-diastole (MLd).
Because MLs is smaller than MLd, peak GLS is a negative number.

Color-encoded ROI(Parametric preview) Segmentéﬁ%éé%nal Strain curves

Peak Systolic Longitudinal Strain

Antsept

-

Peak SystoliclBngirudinalStrain

basPosty
232

Peak segmental Strain map Curved anatomical color M-mode Bull’s eye plot(Peak Systolic Longitudinal Strain)

» Left Ventricle Strain
LV systolic function should be routinely assessed using 2DE or 3DE by calculating EF from EDV and ESV.
LV EFs of <52% for men and <54% for women are suggestive of abnormal LV systolic function.

Two-dimensional STE-derived GLS appears to be reproducible and feasible for clinical use and offers
incremental prognostic data over LV EF in a variety of cardiac conditions, although measurements vary among
vendors and software versions.

To provide some guidance, a peak GLS in the range of -20% can be expected in a healthy person, and the lower
the absolute value of strain is below this value, the more likely it is to be abnormal.

¢ Angle independent « Vendor dependent
o Established
prognostic value

Global Longitudinal
Strain.

Peak value of 2D

longitudinal speckle

tracking derived strain

(%).

2D, two-dimensional; 3D, three-dimensional; A2C, apical 2-chamberview; A4C, apical 4-chamberview; EDV, end-diastolic volume; ESV, end-sys-
tolic volume; LV, left ventricular.
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FAC

SAMSUNG

FAC provides an estimate of global RV systolic function. It is important to ensure that the entire right ventricle
be contained in the imaging sector, including the apex and the free wall, during both systole and diastole.
While tracing the RV area, care must be taken to include the trabeculae in the RV cavity.

RV FAC < 35% indicates RV systolic dysfunction.

RV global systolic function
FAC RV FAC in RV-focused
apical four-chamber view:

ESA)/EDA

FAC = (EDA-ESAVEDA = (23.7-13,9)/23.7 = 41%

TAPSE

» Established prognostic
value RV outflow tract to overall

¢ Reflects both longitudinal
and radial components of
RV contraction

+ Correlates with RV EF by
CMR

RV FAC (%) = 100 x (EDA —

+ Neglects the contribution of

systolic function
« Only fair inter-observer
reproducibility

TAPSE is easily obtainable and represents a measure of RV longitudinal function. It is measured by M-mode
echocardiography with the cursor optimally aligned along the direction of the tricuspid lateral annulus in the
apical four-chamber view. Although this index predominantly reflects RV longitudinal function, it has shown
good correlations with parameters estimating RV global systolic function, such as radionuclide-derived RV EF,
2D echocardiographic RV FAC, and 2D echocardiographic EF. As a one-dimensional measurement relative to
the transducer position, TAPSE may over or underestimate RV function because of cardiac translation.

Although there may be minor variations in TAPSE values according to gender and BSA, generally, TAPSE <17

mm is highly suggestive of RV systolic dysfunction.

Echocardiographic imaging Recommended methods

Advantages Limitations

RV longitudinal systolic function
TAPSE

+ Tricuspid annular longitudi-
nal excursion by M-mode
(mm), measured between
end-diastole and peak sys-
tole

Proper alignment of M-
meode cursor with the direc-
tion of RV longitudinal
excursion should be
achieved from the apical
approach.

Table 10 Normmal values for parameters of RV function

+ Established prognostic

value ¢ Partially representative of
» Validated against radionu-

+ Angle dependency

RV global function*
clide EF

Parameter Mean + SD Abnormality threshold
TAPSE (mm) 24+ 3.5 <17
Pulsed Doppler S wave (cm/sec) 14123 <9.5
Color Doppler S wave (cm/sec) 9.7+ 1.85 <6.0
RV fractional area change (%) 49 = 7 <35
RV free wall 2D strain* (%) —29+45 =—20 (<20 in magnitude with the
negative sign)
RV 3D EF (%) 58 £ 6.5 <45
Pulsed Doppler MPI 0.26 = 0.085 =>0.43
Tissue Doppler MPI 0.38 + 0.08 =0.54
E wave deceleration time (msec) 180 + 31 <119 or 242
E/A 1.4+03 <0.8 or>2.0
e'fa’ 118 £ 0.33 <0.52
e 14.0 = 3.1 <7.8
E/e 40x1.0 =>6.0

MPI, Myocardial performance index.

“Limited data; values may vary depending on vendor and software version.
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Strain+ (LV Strain) SAMSUNG

SAMSUNG

Feature

« LV Global longitudinal strain (GLS) is the optimal parameter of deformation for the early detection of
subclinical left ventricle dysfunction.

+ Quantitative tool for wall motion of the left ventricle using advanced speckle tracking technology.
Samsung System automatically contours myocardium for the Strain+, supports quick and simple procedure.

Clinical Benefit

« Measure of deformation along the longitudinal axis of the heart, providing a quantitative assessment of
global left ventricular systolic function.

» By detecting subtle changes in Left ventricular function, assess regional wall motion abnormalities.

* GLS, Global longitudinal strain value is helpful to predict Left ventricle function. With fast and reproducible
study, Strain+ can be apply to a daily practice.

+ Able to revise and edit the myocardium contour.

» 17 or 18 segment of bulls eye view is provided. (Based on the ASE Guideline, apply 17 segments as Default.)

Tips

» Itisrecommended to do the LV Strain+ with cine data that left sided direction marker for higher accuracy.

Frozen 2D

Main

Anatomical M

Gray Map
8

StressEcho

Auto EF

TMAD

Full Cine Save Cine Play Auto MedSure
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StressEcho SAMSUNG

5 Rest > PLAX Rest2PSAX
Gen .
oh 110 it € Unable To Interpret i
FA 3
e » N @ Normal
e - p Hypokinetic
: > © Akinetic
T . w z @ Dyskinetic
i i B : © Aneurysmal
a & Akinetic with Scar
Peak > PLAX
=~ T1 03:56 . . .
et @ Dyskinetic with Scar
B \ Not Scored
, -~

@ Not Scored Segements Normal
@ All segements Normal

= All Segements Not Scored
= 7 R: 6 HR|: 74 12

Feature
« Stress echocardiography (SE) is most commonly used to evaluate ischemic heart disease.

« The stress can be triggered by either exercise on a treadmill(bicycle) or a medicine called dobutamine.

Benefit
« Indication of SE : Diagnosing coronary artery disease, Assessing valve disease, Identifying ischemia.
* It can help detect early signs of coronary artery disease, arrhythmias and other cardiac conditions.

+ StressEcho stage Template is customizable according to a hospital’s study protocol.

Two Stage Exercise Stress)New

PLAX
Template Editor

Two Stage Exercise Stress - NEW 4 | . | . |
Two Stage Exercise Stress e 3
Rest N s » }
Three Stage Bicycle Stress V
4 3 s
Four Stage Pharamacological Stress > g :
Diastolic Stress
A4C A2C
Dobutamine Stress > v
e v 2 3
Peak 5 6 7
» | . | | . |
= i &
X sy 4 1
Peak - 1 ; t !
.
Template Editor : »
Start/Continue End Protocol Release Release All Review Close
Grid Capture Method Timer Additional Options
Stage View Prospective Show Protocol Timer (T1) Go to "Select Cine’ after continuous capture per stage
2 — | o 4 — | 5 Retrospective Show Stage Timer (T2) Go to ‘Select Cine’ after multi-assign perview
Go to Review Screen after end of acquisition
Import Export Save As Apply & Exit Cancel
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Clinical Information about StressEcho SAMSUNG

WMS (Wall Motion Scoring)
+ Wall Motion Scoring index is a unitless number that measures the wall motion response during stress.

+ WMSindex is directly proportion to the severity and extent of wall motion abnormalities.
To calculate the WMS index, each Left ventricular segment is given a score based on its systolic function:

- Normal : 1 Left Ventricular Segment Area number
- Hypokinesis : 2 Basal Anterior Septum 1
- Akinesis : 3 Basal Anterior 2
_ Dyskinesis: 4 Basal Lateral 3
Basal Posterior 4
Basal Inferior 5
Basal Septum 6
PLAX PSAX-Mid A4C A2C Mid Anterior Septum 7
Mid Anterior 8
Mid Lateral 9
Mid Posterior 10
Mid Inferior 1
APLAX PSAX-Base PSAX-Apex Mid Septum 12
Apical Septum 13
Apical Anterior 14
Apical Lateral 15
Apical Inferior 16
* All stress echo responses follow four basic patterns : Table 2 Stress echocardiography in four equations
- Normal (Rest = Stress = Normal function) Rest + Stress = Diagnosis

- Ischemia (Rest = Normal, Stress = Abnormal) Normokinesis + Normo-Hyperkinesis = Normal

Normokinesis + Hypo, A, Dyskinesis = |schaemia
Akinesis + Hypo, Normokinesis = Viable
A-, Dyskinesis 4+ A-, Dyskinesis = Necrosis

- Necrotic (Rest = Stress = Abnormal)

- Viability (Rest = Abnormal, Stress = Normal or Biphasic)

* Clear endocardial definition is crucial for optimal interpretation and it is recommended that harmonic imaging, when
available, be routinely used for optimal endocardial border detection. Contrast-enhanced endocardial border detection
could be used when suboptimal imagining is present.

EAE Guidelines (European Journal of Echocardiography(2008) 9, 415-437)
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UterineAssist™ SAMSUNG

Tn,w; AR/ 60GH 1 3THE W Frozen 2D UterineAssist

Transverse

Uterus Length Uterus Height

» Flexion M
S Anteflexion 7 *©

Assign to Report

(Asymmetry Marker | Sagittal Measure —

Preview

Feature

« Based on Deep learning technology, UterineAssist™ semi-automatically measures the size and shape of the
uterus.

» Morphological measurement like Endometrium thickness, uterus Length, Height, Width and shape
information like Roundness, Asymmetry are provided with highly simplified workflow.

Clinical Benefit

+ Uterine measurement is routine check up in Gynecology study to figure out any abnormal status, highly
decreases patient throughput.

» Supports to reduce a time consuming with a single keystroke by providing multiple measurement items,
which are required to do manually.

+ Detailed reporting is available by Providing more manual features like Fluid in the Endometrium, Flexion,
Version and Echogenicity additionally.

Tips

« Select the specific item on the TouchScreen to revise and update the result.
« UterineAssist™ is workable Up/Down Image Mode as well.

+ Change and set a normal standard value range of individual item is available.

Utility > Setup > Measurement > Application Options > GYN > Uterus
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UterineContour™ SANMISUNG

MPR MSV Oblique

Slab3D Volume CT
M . Post
Processing

Chroma
Orientation
Dot

ClearLine

Uterine
Contour

Classification

E

UterineContour™

Feature /

« Afeature based on Deep Learning technology.

+ It automatically extracts the centerline and thickness of the curved endometrium and provides a coronal
view in 3D, flattened by the centerline.

Benefit
* Reduces the time required to manually find the endometrium.
« ltisto help inidentifying uterine malformation and IUD location.

« Uterine malformation classification are reported according to the ESHRE/ESGE or ASRM guideline selection.

- ESHRE/ESGE: The European Society of Human Reproduction and Embryology
The European Society for Gynecological Endoscopy
- ASRM: The American Society for Reproductive Medicine

Tips
+ Itis enabled under the Gynecology Application.
* You can configure the Classification settings in Utility> Setup > Measurement > Gynecology.

« Ableto directly run the Uterine Contour on the TouchScreen in B-Mode by tapping the UterineContour™
Button with 3D endo-transducer.

» Acquire 3D Volume - Touch ‘Uterine Contour’

- Automatically provides the coronal plane of the uterus.
- Select the item that matches the uterine shape of the examined coronal plane.
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ViewAssist™ SAMSUNG

etal Heart / CV1-8A/ 10.0cm 2 s 1 03/M 10

Mo Arch I

Feature
« Afeature based on deep learning technology.

« Automatically classifies ultrasound images with view recognition technology, the feature is automatically
performed and show proper annotation or measurement when the user selects ‘Auto Annotation’ or ‘Auto
Measure’ without giving any specific indication to the system.

Benefit

« Improve workflow efficiency with automation features that reduce the number of steps required to enter
measurements and annotations for each item each time.

Tips
» Activated under Frozen 2D mode condition in OB Application.

+ Activate ‘Auto Annotation’ by touching it on the touch-screen.
- Automatically displays the proposed view names and corresponding anatomic annotation.
If the user wishes to modify it, press [Text] to edit the text.

+ Activate 'Auto Measure' by touching it on the touchscreen.
Alternatively, you can do this by pressing the '%f.\_" button in the control panel after pre-setting in
Settings. N

Utility > Setup > Assist > OB (Application)

(VI Start AutoMeasure by Pressing Measure Key
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Voice Command SAMSUNG

Display ~ Patient  PresetList

Feature

« Experience seamless, hands-free scanning with Voice Command, enabling an efficient workflow and sterile
operation control through simple spoken instructions.

Benefit

« Voice Command enhances the clinical workflow by allowing hands-free operation, reducing the need for
physical contact with the system during procedures.

+ This is particularly valuable in sterile environments, helping to maintain infection control while improving
efficiency and focus during examinations.

Tips
 Activate via the microphone icon or a custom "Wake Word" (e.g., "Hey Assist") for hands-free control.

« Customize your experience by setting the Listening Mode (Single/Multiple), Voice Feedback, and your
personalized Wake Word.

» o«

* Operate the system with simple commands such as “B Gain Up”, “Freeze”, and “Image Save”. See the list
below for more.

P Patient » B Mode, B Gain Up/Down P Measurement P Dual Live, Single
» Depth Up/Down = » M Mode, M Gain Up/Down P Caliper > Exit
» Focus Up/Down » CMode, C Gain Up/Down P Annotation P Freeze
» Zoom Up/Down P PD Mode, PD Gain Up/Down P> BodyMarker P Image Save
P> PW Mode, PW Gain Up/Down | P Context Left/Right = » Cine Save
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Button Probe SAMSUNG

Feature

» Enable truly sterile operation—without direct touch or additional assistance, supports broader

functionality.

Clinical Benefit & Tips

+ Button Probe & Voice command : No need to touch ultrasound device during the US-Guided Procedure
(Support Built-in Camera and Microphone).

» Dual side buttons provide identical functionality for both hands Frequently used functions can be assigned.

+ The settings for the Button Probe are configurable in the Utility > Setup > Customize > Button Probe.

User-defined mapping up to 4 functions

Function

F A Change | Mcain || Depth |-+ Focus |»| color
£\ t 3

o

() @ On-screen |e

LA2-16Sc
Both hands support
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EVO Q10 Transducer Line-up SAMSUNG

~ CAI-75D D o)

OB, Abdomen, GYN, MSK, Pediatric, Thoracic,

Vascular, Urology, Emergency \
Convex =
CA2-8AD v
OB, Abdomen, GYN, MSK, Pediatric, /
Vascular, Urology, Emergency \ '

LA2-16Sc 2D &9

Abdomen, MSK, Small Parts, Vascular,
Pediatric, Emergency 5

LA3-16ADc

Abdomen, MSK, Small Parts, Vascular,
Pediatric, Emergency

LA2 -16S

Abdomen, MSK, Small Parts, Vascular,
Pediatric, Emergency

. LA3-16AD %
Linear Abdomen, MSK, Small Parts, Vascular,
Pediatric, Emergency \

LA3-22Al / |

MSK, Intraoperative, Dermatology

L3-22

MSK, Small Parts, Vascular, Pediatric,
Dermatology

LA2-9SD 3

Abdomen, MSK, Small Parts, Thoracic,
\ Vascular, Pediatric, Emergency j
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EVO Q10 Transducer Line-up

SAMSUNG

Phased
Array

PA1-5AED

Abdomen, Cardiac, TCD, Pediatric, Vascular,
Thoracic, Emergency

\*

PA2-9S

Abdomen, Cardiac, TCD, Pediatric, Vascular

PA3-15S

Abdomen, Cardiac, TCD, Pediatric, Vascular

TEE

MMPT3-7

Cardiac

TA2-9

Cardiac

CW

CWé6.0

Cardiac, Vascular, TCD

DP2B

Cardiac, Vascular, TCD

&
&
-~
<
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SAMSUNG

Disclaimer

» Before using the material, proceed the review of the local advertising regulation through your RA and
legal team.

« The products, features, options, and transducers may not be commercially available in some countries.

« Sales and shipments are effective only after the approval by the regulatory affairs. Please contact your

local sales representative for further details.
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